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Documentation UpdatesThis guide’s title page contains the following identifying information:
• Software Version number, which indicates the software version.
• Document Release Date, which changes each time the document is updated.
• Software Release Date, which indicates the release date of this version of the software.To check for recent updates, or to verify that you are using the most recent edition of a document, visit the following URL:

http://h20230.www2.hp.com/selfsolve/manuals You will also receive updated or new editions if you subscribe to the appropriate product support service. Contact your HP sales representative for details.
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SupportFor information or assistance regarding WebInspect Enterprise, contact customer support.You can open a support case for WebInspect Enterprise via e-mail, online, or by telephone. These options are designed to provide easier access and improved customer satisfaction.
E-Mail (Preferred Method)Send an e-mail to fortifytechsupport@hp.com describing your issue. Please include the product name so we can help you faster. 
Online (Fortify Support Portal)Access your account at the Fortify Support Portal at https://support.fortify.com If you do not have an account, you forgot your username or password, or you need any assistance regarding your account, please contact us at fortifytechsupport@hp.com or (650) 735-2215.
TelephoneCall our automated processing service at (650) 735-2215. Please clearly provide your name, telephone number, the name of the product, and a brief description of the issue. 
You can access the HP Application Security Community containing customer forum and blogs at: 

http://h30499.www3.hp.com/t5/Application-Security-Community/ct-p/sws-AS You can also visit the HP software support Web site at:
http://support.openview.hp.com/ This web site provides contact information and details about the products, services, and support that HP Software offers.HP Software online support provides customer self-solve capabilities. It provides an efficient way to access interactive technical support tools needed to manage your business. As a valued support customer, you can benefit by using the HP Software Support web site to:

• Search for knowledge documents of interest
• Submit and track support cases and enhancement requests
• Download software patches
• Manage support contracts
• Look up HP support contacts
• Review information about available services
• Enter into discussions with other software customers
• Research and register for software trainingMost of the support areas require that you register as an HP Passport user and sign in. Many also require a support contract.To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html 
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Installing WebInspect Enterprise 10.10
System Requirements

Before installing WebInspect Enterprise, make sure that your systems meet the requirements described in 
the HP WebInspect Enterprise System Requirements for version 10.10. This installation guide also refers to 
the HP WebInspect Enterprise User Guide for detailed information. Both documents are available at: 

https://download.hpsmartupdate.com/wie

Installing or Upgrading HP Fortify Software Security Center 

HP Fortify Software Security Center (SSC) version 4.00 must be installed and running before you install 
WebInspect Enterprise version 10.10. See the HP Fortify Software Security Center Installation and 
Configuration Guide for information about installing or upgrading SSC to the required version.

In SSC:

• Note the SSC URL. You will need to specify it during the installation of WebInspect Enterprise. 

• Create a general SSC administrator account or make note of an existing one. You will need to specify 
the user name and password of this account during the installation of WebInspect Enterprise.

• Create an account in SSC for the WebInspect Enterprise Service and give it the role of WebInspect 
Enterprise System. This service controls the sharing of project versions with WebInspect Enterprise and 
obtains lists of scans and running scans from WebInspect Enterprise. You will need to specify the user 
name and password of this account during the installation of WebInspect Enterprise.

For information about creating accounts in SSC, see the HP Fortify Software Security Center User Guide. 
The HP Fortify Software Security Center documentation set contains installation, user, and deployment 
guides for all HP Fortify Software Security Center products and components. In addition, technical notes 
and release notes describe new features, known issues, and last-minute updates. To obtain the latest versions 
of these documents, go to the HP Software Product Manuals site:

http://h20230.www2.hp.com/selfsolve/manuals 

To access this web site, you must first obtain an HP Passport account.

Upgrading from WebInspect Enterprise 9.30 or 10.00

You can upgrade to WebInspect Enterprise version 10.10 directly from version 9.30 or version 10.00. If you 
upgrade from version 9.30, during installation you will see additional screens related to supporting single 
sign-on with Software Security Center (SSC), as described in the procedure in this document. 

Also, be sure to review the preceding section, Installing or Upgrading HP Fortify Software Security Center.
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Preparing to Install WebInspect Enterprise 

Prepare to install WebInspect Enterprise as described in this section. 

First, see Installing or Upgrading HP Fortify Software Security Center on page 5.

On a Microsoft Windows server: 

1 Install IIS as follows. You must install IIS before installing Microsoft .NET Framework 4.0.

a Open the Windows Server Manager.

b Click the Roles option, and click Add Roles under Roles Summary in the Roles pane.

The Add Roles Wizard opens.

c Click Next. 

d In the Select Server Roles dialog, make sure the Web Server (IIS) option is selected (installed). 

e Close the wizard.

f Under Role Services in the Roles pane, click Add Role Services. 

g In the list of role services in the Select Role Services dialog, under Management Tools select the 
IIS6 Management Compatibility option (which also selects all of its suboptions).

h Click Next. 

i Click Install to complete the installation of IIS.

2 Install Microsoft .NET Framework 4.0. 

3 Enable ASP.NET v2.0 and v4.0 for ISAPI and CGI: 

a In the Server Manager window, under Server Manager (<localhost>), select 
Roles → Web Server (IIS) → Internet Information Services (IIS) Manager. 

b In the Internet Information Services (IIS) Manager window, select the localhost in the Connections 
pane.

c In the IIS section, double-click the ISAPI and CGI Restrictions icon.

d In the ISAPI and CGI Restrictions pane, if any Restriction value for an ASP.NET v2.0.xxxxx entry 
or an ASP.NET v4.0.xxxxx entry is set to Not Allowed, right-click that entry and select Allow. 

If you receive an error message indicating that the feature cannot be installed because your operating 
system lacks IIS Management Compatibility, make sure you followed the preceding steps correctly.

4 Install SQL Server software if it is not already installed.
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Installing WebInspect Enterprise

Installation of WebInspect Enterprise is driven by a series of wizards as described in the following sections. 
The major steps are:

• Installing the WebInspect Enterprise Server software, using the WebInspect Enterprise Setup Wizard

• Initializing the software, using the WebInspect Enterprise Initialization Wizard

• Configuring the Scan Uploader, Task, and Scheduler services

• Installing the WebInspect Enterprise Administrative Console, using the WebInspect Enterprise Console 
Setup Wizard

• Installing WebInspect as a sensor if not done during initialization

Installing the WebInspect Enterprise Server Software

Install the WebInspect Enterprise server software on the server by running the Setup Wizard: 

1 Launch the WIE Server installation file.

Note: If the wizard detects a previous installation of the WebInspect Enterprise server software, use the 
wizard to remove it and then relaunch the installation file.

The Welcome screen of the HP WebInspect Enterprise 10.10 Setup wizard appears. 

2 Click Next. 

The End-User License Agreement dialog appears.

3 Review the license agreement. If you accept it, select the check box and click Next; otherwise click 
Cancel. 
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If you accept the license agreement, the Product Features dialog appears. (Memory requirements stated 
for the features might vary slightly from the values shown in the following screen capture.)

4 On the Product Features dialog: 

a Select the components you want to install.

WebInspect can scan a Web site and export the scan results to a location called a “dropbox.” The 
Scan Uploader Service accesses each dropbox periodically and, if files exist, it uploads those files 
to the WebInspect Enterprise Manager. To install the WebInspect Enterprise Scan Uploader 
Service, click the associated x icon, and then in the drop-down list click Will be installed on local 
hard drive. 

b Accept the default location or click Browse to select the location where you want to install the 
software.

c Click Next.

The Ready to install HP WebInspect Enterprise 10.10 dialog appears.

5 When you are ready to install, click Install. 
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WebInspect Enterprise 10.10 software is installed on the computer and the Setup Wizard completes.

6 Click Finish. 

Initializing the Software

After the Setup Wizard completes, the Welcome screen of the HP WebInspect Enterprise Initialization 
Wizard appears.

The Initialization Wizard initializes the software as described in this section. Its functions include:

• Activating the WebInspect Enterprise license

• Creating and updating the WebInspect Enterprise database

• Creating the WebInspect Enterprise website and web service

• Connecting WebInspect Enterprise and HP Fortify Software Security Center (SSC)

Note: The Initialization Wizard is always available as the WebInspect Enterprise Initialize option in the 
Start → All Programs → HP → HP WebInspect Enterprise 10.10 menu, so that initialization can be 
restarted in the future if necessary.
9



Run the Initialization Wizard:

1 Click Next.

The Activate WebInspect Enterprise License dialog appears. 

2 Enter the Activation ID that HP sent to you.

3 Do one of the following:

• If the computer is connected to the Internet, select Online Activation.

If you are using a proxy server, select Use Proxy Server, click Edit, and provide the requested 
information.

• If the computer is not connected to the Internet, select Offline Activation and then click File to 
select the location on this computer where you want the installation software to create a license 
request file named LicenseRequest.xml. This file will contain information about the 
computer that is required to obtain a license.

4 Click Next.

The WebInspect Enterprise License user information dialog displays user information as submitted to 
HP. 

5 Correct the information as needed and click Next.
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6 If you selected Online Activation in step 3, go to step 8 on page 13.

7 If you selected Offline Activation in step 3, the Complete Offline License Activation dialog appears. It 
indicates that the license request file was generated successfully. Perform the procedure in this step to 
download from HP a license response file named LicenseResp.xml that you can copy to the 
computer, not connected to the Internet, on which you are installing WebInspect Enterprise.

a Copy the LicenseRequest.xml file you created in step 3 to a portable device such as a flash 
drive.

b Copy the LicenseRequest.xml file from the portable device to a computer that is connected 
to the Internet.

c Open a browser and navigate to

https://LicenseService.HPSmartupdate.com/OfflineLicensing.aspx. 
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d Select the option that describes how the license request file was generated and click Next.

The Process Request File window appears.

e Click Browse as needed, select the LicenseRequest.xml file that you copied to this 
computer, and then click Process Request File.

If the request is processed successfully, the following dialog appears:

f Click Retrieve Response File.

g On the File Download dialog, click Save and specify the location on the portable device where you 
want to download the response file LicenseResp.xml.

h Return to the computer on which you are installing WebInspect Enterprise. Copy the 
LicenseResp.xml file from the portable device to a location on this computer.
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i In the WebInspect Enterprise Initialization Wizard, specify the License Response File field by 
clicking File and navigating to the location of the LicenseResp.xml file you just copied from 
the portable device.

j Click Next.

8 The WebInspect Enterprise License Information dialog displays information about the license. Review 
the information.

9 Click Next.

The SQL Server Information dialog appears. 

10 Enter the name of the SQL Server instance in the Database Server field and select the authentication 
that will be used. If you are installing WebInspect Enterprise for the first time, you must have privileges 
to create a database (or your database administrator must create a blank database and assign ownership 
to you).
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11 Click Next.

The Database Selection dialog appears.

12 Select one of the following:

• To use a new database, select Create new database and enter a database name. You must have 
privileges to create this database.

• To use a previous installation of WebInspect Enterprise, select Use existing database and select 
one from the list. You must have owner privileges for that database.

13 Click Next.

14 If you created a new database, skip to step 16.

15 If you are using an existing database for an upgrade from WebInspect Enterprise version 9.30, the 
database must be upgraded, and the WebInspect Enterprise Database Upgrade window appears, 
instructing you to back up that database before upgrading it. After you have backed up the database, 
select the Database is backed up check box and click Next. 

16 The Set Up WebInspect Enterprise Manager Web Service dialog appears. 
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Specify the root Web site and the IIS virtual directory name (WIE in the example above), and select a 
certificate.

These entries create the URLs for the following components:

• WebInspect Enterprise URL for login to the Administrative Console: 

http(s)://<computer name>/<Virtual Directory name>/ 

• Web Console: 

http(s)://<computer name>/<Virtual Directory name>/WebConsole

17 Click Next.

The Set Up the WebInspect Enterprise Manager User dialog appears.

18 Specify the local or domain user account that will run the WebInspect Enterprise website and Web 
service. The User Name should be in the format localhost\administrator.

For WebInspect Enterprise to work properly, this account must be a local administrator. This enables 
the WebInspect Enterprise Manager to install service packs and patches released by HP.

19 Click Next.

The Set Up WebInspect Enterprise Database User dialog appears. 
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20 Specify how the WebInspect Enterprise Manager should connect to the WebInspect Enterprise 
database.

• Windows Authentication - The name and password specified in the WebInspect Enterprise 
Manager’s user account is used to authenticate to the database. When working in a domain 
environment, the WebInspect Enterprise Manager’s user account should be a domain account. 
When working in a workgroup environment, you must have the exact same user name and 
password on both the WebInspect Enterprise Manager and the database computers.

• SQL Authentication - Enter the SQL Server user name and password.

21 Click Next.

The Set Up SSC Connection Information dialog appears.

The WebInspect Enterprise URL field has a default value based on previous configuration. 

Specify the Software Security Center URL. See Installing or Upgrading HP Fortify Software Security 
Center on page 5.

22 Click Next.

The Software Security Center Users dialog appears.
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Make sure that SSC is running and that an SSC administrator is logged on. 
In the Software Security Center Users dialog, specify the SSC accounts for that administrator and for 
the WebInspect Enterprise Service Account. See Installing or Upgrading HP Fortify Software Security 
Center on page 5.

If you are performing an upgrade from WebInspect Enterprise version 9.30, an additional field named 
Default Group appears in the Administrator section. The drop-down list displays the current set of 
parent organizations and their groups. Select one to use for saving project versions sent from SSC. This 
field is provided in case you previously renamed the default organization or default group in 
WebInspect Enterprise.

23 Click Next.

The installation software verifies that WebInspect Enterprise can access the SSC server and use the SSC 
accounts you specified.

The Ready To Start dialog appears.

24 Verify your previous choices. 

• To change settings, click Back. 
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• To begin initializing WebInspect Enterprise using the values you have specified, click Next. The 
initializer creates the database and configures various system components, adding a new step to the 
Status list as each previous step completes. Project versions in SSC are imported into WebInspect 
Enterprise. When the initialization completes successfully, the window appears similar to the one 
shown below. 

25 Click Next. 

The SSC administrator you specified in step 22 on page 16 automatically becomes the first (and only) 
System Administrator in WebInspect Enterprise. 

Note: If that person becomes unavailable, no one knows his password, and he did not create other 
System Administrators in WebInspect Enterprise, it might seem that there would be no way to 
administer WebInspect Enterprise. However, you can rerun the Initializer (Start → All Programs → 
HP → HP WebInspect Enterprise 10.10 → WebInspect Enterprise Initialize) and specify another 
SSC administrator in step 22. Then at this point in the initialization process, the Initializer would detect 
that your newly specified SSC administrator exists in SSC but she is not a System Administrator in 
WebInspect Enterprise. In this case, the Initializer would display an Administrator Role Page that 
allows you to add her to WebInspect Enterprise with the System Administrator role, by selecting the 
Add Current User to System Administrator Role check box and clicking Next.

The Connecting to WebInspect Enterprise Manager screen appears until the connection is made. 
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26 If you are not upgrading a WebInspect Enterprise version 9.30 installation, skip to step 28.

27 WebInspect Enterprise version 10.10 and SSC use single sign-on functionality, with a common set of 
user accounts that are specified in SSC, whereas WebInspect Enterprise 9.30 accounts use NTLM 
authentication and are no longer valid. If you are upgrading a WebInspect Enterprise version 9.30 
installation and if you specified in step 11 on page 14 that you want to continue to use its database, a 
Legacy Users dialog appears that requires you to do one of the following:

• Remove all existing (legacy) WebInspect Enterprise accounts. 

• Map (assign) some or all of the existing WebInspect Enterprise accounts to existing SSC accounts. 
If you select this option, a dialog opens for you to make the desired mappings. You can map any 
number of legacy accounts to the same SSC account. Any legacy account that you do not map to an 
SSC account is removed. Each SSC account will inherit the roles and privileges of the legacy 
WebInspect Enterprise account(s) that are mapped to it. 

28 The Sensor Users dialog appears. 

Add (create) at least one sensor user for WebInspect Enterprise to use to run scans. Sensor users must 
not be general console users. 

You do not have to add any sensor users in this step, but you must specify at least one sensor user before 
you can run any scans. If you create sensor users later, do so using the WebInspect Enterprise 
Administrative Console, and then configure them when installing WebInspect as a sensor. For more 
information, see Installing WebInspect as a Sensor on page 27 if WebInspect has not been installed as a 
sensor, and see Creating Sensor Users on page 33 and Configuring Sensors on page 33.

To add a sensor:

a Click Add.

b In the Select Users or Groups dialog, type the name of an existing user to add, in the format of 
localhost\user. If you specify only the user, clicking Check Names can help you specify the host.

c Click OK. 

d Verify that the sensor user you specified has been added to the list of Sensor Users.
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29 Click Next.

The Initialization Wizard completes.

30 Click Finish. 

The Initialization Wizard closes.

Configuring Services 

Use the WebInspect Enterprise Services Configuration Utility to configure or modify services associated 
with WebInspect Enterprise. Make sure the services are started even if you do not change any options.

To start the utility, click Start → WebInspect Enterprise Services Manager. 

After starting the utility, the following buttons appear in the left column:

• Scan Uploader Service - Handles the transfer of scans from WebInspect to WebInspect Enterprise.

• Task Service - Monitors the queue for various tasks, including the archiving and restoring of scans.

• Scheduler Service - Handles the scheduling of scans, discovery scans, and smart updates.

Perform the procedures in the following sections after selecting each of these services.

Scan Uploader Service

WebInspect can scan a Web site and export the scan results to a location called a “dropbox.” The Scan 
Uploader Service accesses each dropbox periodically and, if files exist, it uploads those files to the 
WebInspect Enterprise Manager. 

Service Status

This area of the interface reports the current status of the Scan Uploader service. You can start, stop, restart, 
or configure the service.

To configure the service:

1 Click Configure in the Service Status section.

The Configure Service dialog appears.
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2 Select which credentials should be used for logging on to the service: 

• Local system account - The LocalSystem account is a predefined local account used by the 
service control manager (SCM). It has extensive privileges on the local computer, and acts as the 
computer on the network. A service that runs in the context of the LocalSystem account inherits the 
security context of the SCM. 

• This account - An account identified by the credentials you specify.

3 If you select This account, enter an account name and password. 

4 Click OK.

WebInspect Enterprise Configuration

This area of the interface reports the WebInspect Enterprise configuration.

To configure WebInspect Enterprise:

1 Click Configure in the WebInspect Enterprise Configuration section. 

The WebInspect Enterprise Configuration dialog appears.

2 Enter the URL of the WebInspect Enterprise Manager.

3 Provide the WebInspect Enterprise Manager's authentication credentials.

4 To verify that the user name and password are correct, click Test.

5 If the Scan Uploader service uses a proxy, select Enable Proxy and provide the requested information.

6 Click OK.

Dropbox Configuration

WebInspect can scan a Web site and export the scan results to a location called a “dropbox.” The purpose of 
the WebInspect Enterprise Uploader service is to access each dropbox periodically and, if files exist, to 
upload those files to the WebInspect Enterprise Manager.

To create a dropbox:

1 Click Add in the Dropbox Configuration section.

The Configure Dropbox dialog appears.

2 Enter a dropbox name. 

3 Enter the full path and name of the folder that will be used as the dropbox (or click Browse to select or 
create a folder). 

Be sure to select or create a folder that will not be used for any other purpose.

4 Select a site that will be serviced by this dropbox. 

5 Click OK.

Logging Configuration

This area of the interface reports current settings for the logging function.

To configure settings:

1 Click Configure in the Logging Configuration section. 

The Logging Configuration dialog appears.
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2 The logging output is contained in Scheduler_trace.log. To specify the location of the logs, 
choose one of the following: 

• Default location 

On Windows Server 2003, the location is:

\Documents and Settings\All Users\Application Data\HP\WIE\Scheduler 

On Windows Server 2008, the location is:

\ProgramData\HP\WIE\Scheduler 

• Enter location for log file 

Type a path to the folder that will contain the logs, or click Browse to select a location.

3 For the logging level, choose either INFO (the default) or DEBUG (which records more data). 

4 Specify the maximum file size of a log file (in megabytes). 

5 Specify the maximum number of log files that will be retained.

When a log file reaches its maximum size, WebInspect Enterprise closes it and opens another file, 
repeating this process until the maximum number of log files is created. When that file is full, 
WebInspect Enterprise closes it, deletes the oldest file, and opens a new one. Files are named in 
sequence: Scheduler_trace.log, Scheduler_trace.log.1, etc. 

Start the Service

Click Start in the Service Status section to start the service if it is not already running.

Task Service

Service Status

This area of the interface reports the current status of the Task service, which handles background tasks such 
as archiving and restoring assessments and scans. You can start, stop, restart, or configure the service.

To configure the service:

1 Click Configure in the Service Status section. 

The Configure Service dialog appears.

2 Select which credentials should be used for logging on to the service: 

• Local system account - The LocalSystem account is a predefined local account used by the 
service control manager (SCM). It has extensive privileges on the local computer, and acts as the 
computer on the network. A service that runs in the context of the LocalSystem account inherits the 
security context of the SCM. 

• This account - An account identified by the credentials you provide.

3 If you select This account, enter an account name and password. 

4 Click OK.

Database Configuration

This area of the interface reports the database server name and database name.

To configure the database:

1 Click Configure in the Database Configuration section. 

The Database Configuration dialog appears.
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2 Enter a server name. 

3 Specify the account under which WebInspect Enterprise will connect to the database. 

• Windows Authentication - The name and password specified in the WebInspect Enterprise 
Manager’s user account is used to authenticate to the database. When working in a domain 
environment, the WebInspect Enterprise Manager’s user account should be a domain account. 
When working in a workgroup environment, you must have the exact same user name and 
password on both the WebInspect Enterprise Manager and the database computers. 

• SQL Authentication - Enter the SQL Server user name and password.

4 Select a database.

5 Click OK.

Logging Configuration

This area of the interface reports current settings for the logging function.

To configure settings:

1 Click Configure in the Logging Configuration section. 

The Logging Configuration dialog appears.

2 The logging output is contained in TaskService_trace.log. To specify the location of the logs, 
choose one of the following: 

• Default location 

On Windows Server 2003, the location is:

\Documents and Settings\All Users\Application Data\HP\WIE\TaskService 

On Windows Server 2008, the location is:

\ProgramData\HP\WIE\TaskService 

• Enter location for log file 

Type a path to the folder that will contain the logs, or click Browse to select a location.

3 For the logging level, choose either INFO (the default) or DEBUG (which records more data). 

4 Specify the maximum file size of a log file (in megabytes). 

5 Specify the maximum number of log files that will be retained.

When a log file reaches its maximum size, WebInspect Enterprise closes it and opens another file, 
repeating this process until the maximum number of log files is created. When that file is full, 
WebInspect Enterprise closes it, deletes the oldest file, and opens a new one. Files are named in 
sequence: TaskService_trace.log, TaskService_trace.log.1, etc. 

SSC Poll Interval

This area of the interface determines how often WebInspect Enterprise contacts SSC for updates.

SSC project version updates polling interval - Specify (in seconds) how frequently WebInspect 
Enterprise contacts SSC to check for project version name changes or deletions.

SSC issue synchronization interval - Specify (in minutes) how frequently WebInspect Enterprise contacts 
SSC to check for changes to audit information, comments, attachments, and “not an issue” and “suppressed” 
status.
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Start the Service

Click Start in the Service Status section to start the service if it is not already running.

Scheduler Service

Service Status

This area of the interface reports the current status of the service. You can start, stop, restart, or configure the 
service.

To configure the Scheduler service:

1 Click Configure in the Service Status section. 

The Configure Service dialog appears.

2 Select which credentials should be used for logging on to the service: 

• Local system account - The LocalSystem account is a predefined local account used by the 
service control manager (SCM). It has extensive privileges on the local computer, and acts as the 
computer on the network. A service that runs in the context of the LocalSystem account inherits the 
security context of the SCM. 

• This account - An account identified by the credentials you specify.

3 If you select This account, enter an account name and password. 

4 Click OK.

WebInspect Enterprise Manager

If the WebInspect Enterprise Manager URL is changed using IIS or another tool, change the URL here as 
well.

Logging Configuration

This area of the interface reports current settings for the logging function.

To configure settings:

1 Click Configure in the Logging Configuration section. 

The Logging Configuration dialog appears.

2 The logging output is contained in UploaderService_trace.log. To specify the location of the 
logs, choose one of the following: 

• Default location 

On Windows Server 2003, the location is:

\Documents and Settings\All Users\Application Data\HP\WIE\
UploaderService 

On Windows Server 2008, the location is:

\ProgramData\HP\WIE\UploaderService 

• Enter location for log file 

Type a path to the folder that will contain the logs, or click Browse to select a location.

3 For the logging level, choose either INFO (the default) or DEBUG (which records more data). 

4 Specify the maximum file size of a log file (in megabytes). 
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5 Specify the maximum number of log files that will be retained.

When a log file reaches its maximum size, WebInspect Enterprise closes it and opens another file, 
repeating this process until the maximum number of log files is created. When that file is full, 
WebInspect Enterprise closes it, deletes the oldest file, and opens a new one. Files are named in 
sequence: UploaderService_trace.log, UploaderService_trace.log.1, etc. 

Start the Service

Click Start in the Service Status section to start the service if it is not already running.

Close the WebInspect Enterprise Services Configuration utility.

Installing the WebInspect Enterprise Administrative Console 

For system requirements and notes about the WebInspect Enterprise Administrative Console, see the 
HP WebInspect Enterprise System Requirements.

To install the WebInspect Enterprise Administrative Console, along with the various WebInspect Enterprise 
tools:

1 Launch the WIE Console installation file. 

Note: If the wizard detects a previous installation of the Administrative Console, use the wizard to 
remove it and then relaunch the installation file.

The Welcome screen of the HP WebInspect Enterprise 10.10 Console Setup wizard appears.

2 Click Next. 

The End-User License Agreement dialog appears.

3 Review the license agreement. If you accept it, select the check box and click Next; otherwise click 
Cancel. 
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If you accept the license agreement, the Destination Folder dialog appears.

4 Accept the default location or click Change to select the location where you want to install the 
software, and click Next.

The Ready to install HP WebInspect Enterprise 10.10 Console dialog appears.

When you are ready to install, click Install. 
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After the WebInspect Enterprise files are installed, the Console Setup Wizard completes.

5 Click Finish. 

Installing WebInspect as a Sensor

If WebInspect Enterprise is not already connected to an instance of WebInspect that is configured as a 
sensor, install WebInspect as a sensor: 

1 Start the WebInspect version 10.1 or 10.0 installation program. (The following steps assume you are 
installing version 10.1.)

The Welcome screen of the HP WebInspect 10.1 Setup wizard appears.

2 Click Next. 

The End-User License Agreement dialog appears.

3 Review the license agreement. If you accept it, select the check box and click Next; otherwise click 
Cancel. 

4 If you accept the license agreement, the Destination Folder dialog appears.
27



5 Accept the default location or click Browse to select the location where you want to install the software, 
and click Next. 

The Sensor Configuration window appears. 

6 If you want to test the sensor username and password credentials before starting the service and/or you 
want to connect the sensor to a remote SQL Server, skip to step 8 and do not configure WebInspect as a 
sensor at this time. You will test the sensor credentials and/or connect to a remote SQL server after you 
complete the WebInspect installation.

7 Complete the fields on the Sensor Configuration window:

a Select the Configure WebInspect as a Sensor option.

b In the Enterprise Manager URL field, specify the WebInspect Enterprise URL. 

c In the Sensor Authentication section, enter the Windows account credentials for this sensor. 

8 Click Next.

The Ready to install HP WebInspect 10.1 dialog appears. 

9 When you are ready to install, click Install.

10 When the installation process is complete, click Finish.

If you configured WebInspect as a sensor, this completes its installation and configuration.

Test Sensor Credentials and/or Specify a Remote SQL Server, If Necessary

If you chose not to configure WebInspect as a sensor in step 6 on page 28, you can now: 

• Optionally test the sensor username and password credentials before starting the service.

• Optionally specify sensor connection to a remote SQL Server.

• Complete the configuration of WebInspect as a sensor.

To perform these tasks:

1 When you launch WebInspect, if SQL Server Express is not installed, you are prompted to either run 
WebInspect and enter remote SQL Server credentials, or close WebInspect and manually install SQL 
Server Express.
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If you choose the option to run WebInspect and enter remote SQL Server credentials, the 
Configure SQL Server dialog appears.

2 Complete the Configure SQL Server dialog.

3 After WebInspect launches, click Start → HP Fortify Monitor to launch the HP Fortify Monitor 
program.

4 Click the HP Fortify Monitor icon in the task tray and click Configure Sensor. 
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The Configure Sensor window appears. 

5 Complete the fields: 

a In the Manager URL field, specify the WebInspect Enterprise URL. 

b In the Sensor Authentication section specify the sensor credentials. If you need to test the 
credentials, click Test. 

c If you need to configure a remote SQL Server, in the Advanced section click the Override 
Database Settings option and then click Configure.

d Complete the Service Account section as needed.

e Click Start to start the sensor service.

f Click OK. 

This completes the configuration of WebInspect as a sensor.
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Post-Installation Configuration

After WebInspect Enterprise installations are complete, perform the procedures described in this section.

Logging on to and Configuring the Administrative Console

To log on to the WebInspect Enterprise Administrative Console, which is also known as the WebInspect 
Enterprise Console:

1 Click Start → HP WebInspect Enterprise 10.10 Console.

The Log On to WebInspect Enterprise window appears.

Note: This window does not appear if you previously selected the option 
Automatically log on when this application starts.

2 Using the Log on to list, enter or select the URL of the WebInspect Enterprise manager.

3 Enter the Username and Password for an account that has permission to access the Administrative 
Console. Initially, the only user you can specify is the SSC Administrator you specified in step 22 on 
page 16 (unless you upgraded from WebInspect Enterprise version 9.30 and mapped existing 
WebInspect Enterprise administrators to SSC users). Thereafter, you can add other WebInspect 
Enterprise administrators, as described in Assigning Administrators and Roles on page 32 and the 
HP WebInspect Enterprise User Guide.

4 Select the option Save password as desired.

5 Select the option Automatically log on when this application starts as desired.

6 To go through a proxy server to reach the WebInspect Enterprise manager:

a Click the Proxy tab.

b Select one of the following:

– Use the Internet Explorer proxy (to use the proxy server specified in 
Tools → Internet Options → Connections → LAN Settings).

– Use the proxy below, and then provide the proxy server’s IP address and port number.

c Provide a valid Username and Password.

7 Click OK.

Note: If you see a message indicating that the server refused the request, you may have entered your user 
name and password incorrectly, or your account may not have been assigned to a role. 

To specify a refresh setting for the WebInspect Enterprise Administrative Console: 

1 From the Tools menu, select Options.

The Options window opens.

2 To refresh the display of WebInspect Enterprise information periodically, select Automatically refresh 
display and specify how often (in seconds) the display should be updated. 

3 Click OK.
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Assigning Administrators and Roles

Administrative authority within WebInspect Enterprise is distributed across three hierarchical levels—
system, organization, and group. Each level has at least one administrator. 

A role is a named collection of permissions. Administrators can define roles and assign users to roles to 
provide them with particular, limited capabilities that are important for security. A single user may be a 
member of more than one role. The roles for each security level (system, organization, and group) contain a 
different set of permission categories such a Policies, Blackouts, and Project Versions. Each category 
contains multiple permissions, such as Can Create, Can View, Can Update, Can Delete, etc.

System Level

WebInspect Enterprise system administrators have all permissions with no IP restrictions. No one else can 
log on until the system administrator assigns other users to roles. The initial WebInspect Enterprise 
administrator is the SSC Administrator you specified in step 22 on page 16 (unless you upgraded from 
WebInspect Enterprise version 9.30 and mapped existing WebInspect Enterprise administrators to SSC 
users). 

A system administrator can:

• Add other users as system administrators.

• Create, rename, and delete organizations. 

• Create roles that allow access to certain WebInspect Enterprise Administrative Console features and 
assign users to those roles (thereby limiting the functions a specific user may perform). 

Organization Level

The system administrator who creates an organization automatically becomes an administrator for that 
organization. 

An organization administrator can:

• Assign other users as organization administrators.

• Determine which objects are available to that organization (for example, select which of the available 
scanning policies may be used by projects within an organization).

• Set the maximum priority level that can be assigned to scans conducted by this organization.

• Create and assign users to roles, thereby limiting their ability to perform various functions or access 
certain features of the WebInspect Enterprise Web Console.

• Copy objects (such as blackouts, policies, e-mail alerts, etc.) or move them from one organization to 
another.

• Create, rename, and delete projects.

You are not required to configure multiple organizations. If you prefer, you may associate all projects with a 
single organization.

Group Level

The organization administrator who creates a group automatically becomes an administrator for that group. 

A group administrator can:

• Assign other users as group administrators.
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• Determine which objects are available to that group (for example, select which of the scanning policies 
made available to the organization may be used by this group).

• Set the maximum priority level that can be assigned to scans conducted by this group (within the limits 
established for the organization’s maximum priority level).

• Specify which URLs or IP addresses may be scanned by this group.

• Create and assign users to roles, thereby limiting their ability to perform various functions or access 
certain features of the WebInspect Enterprise Web Console.

• Copy objects (such as blackouts, policies, e-mail alerts, etc.) or move them from one group to another.

Your first configuration priority should be to create the organization and group hierarchy, define hierarchical 
roles, assign users to those roles, and perform the other functions available from the Administration group, 
Roles and Permissions shortcut.

For detailed information about the hierarchy and roles, see the HP WebInspect Enterprise User Guide. 

Creating Sensor Users

On the WebInspect Enterprise server, you must create at least one user that will be a sensor user. If this was 
already done during installation step 28 on page 19, proceed to Configuring Sensors. Sensor users must not 
be general console users. 

To create a sensor user:

1 Start the Administrative Console if you have not already done so. Click 
Start → HP WebInspect Enterprise 10.10 Console and log on.

2 Select the Administration group in the lower left pane.

3 Select the Sensor Users shortcut in the upper left pane.

4 Click Add in the Sensor Users form in the right pane.

5 In the Select Users or Groups dialog, type the name of a user to add, in the format of localhost\user. If 
you specify only the user, clicking Check Names can help you specify the host.

6 Click OK. 

7 Verify that the sensor user you specified has been added to the list of Sensor Users.

Configuring Sensors

Sensors cannot be used to run scans until you do the following:

1 In the WebInspect Enterprise Administrative Console, select the Sensors group in the lower left pane 
and verify that the sensor you specified has been added to the list of Sensors in the right pane. 

2 Select the sensor, click Action, and if the Enable option is available, click it.

3 Select the Administration group in the lower left pane and select the Roles and Permissions shortcut 
in the upper left pane.

4 Change organization permissions:

a In the Security Group Hierarchy of the Roles and Permissions form in the right pane, select 
Default Organization. 

b In the Organization Permissions section, select the Resources tab.
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c In the Organization Resources section, in the Object Type drop-down list, select Sensors. 

d Select one or more sensors in the Available column and click > to move the sensors you selected to 
the Allowed column, or click >> to move all the Available sensors to the Allowed column.

5 Change group permissions:

a In the Security Group Hierarchy of the Roles and Permissions form, select Default Group. 

b In the Group Permissions section, select the Resources tab.

c In the Group Resources section, in the Object Type drop-down list, select Sensors. 

d Select one or more sensors in the Available column and click > to move the sensors you selected to 
the Allowed column, or click >> to move all the Available sensors to the Allowed column.

Moving Project Versions from the Default Group

When a project version is created in SSC, it is also created automatically in WebInspect Enterprise, where it 
is added to the Default Group in the Default Organization. To view the project versions:

1 Select the Administration group in the lower left pane and select the Roles and Permissions shortcut 
in the upper left pane.

2 In the Security Group Hierarchy of the Roles and Permissions form, select Default Group.

3 In the Group Permissions section, select the Move/Copy Objects tab.

4 In the User Created Group Objects section, in the Object Type drop-down list, select Project Versions.

5 Click Retrieve.

All the project versions are displayed.

If you want a different group to have access to a particular project version in WebInspect Enterprise, select 
the check box for the project version in the list of Object Results and click Move. In the Move Objects 
dialog, specify the Target Organization and Security Group and click Move. 

Repeat this procedure as needed on an ongoing basis.

Configuring WebInspect Enterprise to Publish Scans to SSC

If the SSC URL or WebInspect Enterprise URL settings that you specified in step 21 on page 16 are 
changed, then to publish scans to SSC, you must update the settings in the Administrative Console as 
described in the HP WebInspect Enterprise User Guide. 

Guided Scan

Guided Scan is introduced in WebInspect Enterprise version 10.10. It is the preferred method for performing 
a scan because it directs users through the best steps to configure a scan that is tailored to a particular 
application. The first time a user invokes Guided Scan from WebInspect Enterprise or Software Security 
Center, the Guided Scan client application is downloaded, installed, and launched.

Users who want to run Guided Scan in Mozilla Firefox must download and install the Firefox add-on for the 
.NET Framework Assistant. To obtain it, they can click Add-ons on the Mozilla Firefox Start Page in the 
Firefox browser and search .NET. 

For more information about Guided Scan, see the HP WebInspect Enterprise User Guide. 
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Time Stamping and Scheduling

For some installations, the WebInspect Enterprise Manager and the Administrative Console and/or the Web 
Console reside in different time zones. To accommodate this, the WebInspect Enterprise Manager uses 
Coordinated Universal Time (also known as Greenwich Mean Time or Zulu time) for all time storage and 
manipulation. When a time is to be displayed on the Administrative Console or the Web Console, the 
WebInspect Enterprise Manager converts the time to conform to the time zone in which the console resides. 
Alert emails, however, are time-stamped according to the zone in which the WebInspect Enterprise Manager 
resides.

Universal Time does not honor Daylight Saving Time. Therefore, scheduled scan times will change by one 
hour after the transition between Daylight Saving Time and standard time. For example, suppose you 
schedule a scan to occur daily at 4 p.m. and you are in the Eastern time zone of the United States during the 
Daylight Saving Time period. The WebInspect Enterprise Manager records the settings and will begin the 
scan each day at 8 p.m. Universal Time (which is the equivalent of 4 p.m. Eastern daylight time). However, 
when the transition to standard time occurs, your scheduled scan will begin at 3 p.m. local time instead of 
4 p.m. Even though you set your clocks back one hour, the Universal Time did not change.

Installations Lacking Internet Connection

All HP security products contain digital certificates of authority. When a product starts, the operating system 
attempts to connect to the Internet and download a certificate revocation list from the certificate’s issuing 
authority (VeriSign) to determine if the product’s certificate has been revoked. If the product cannot 
establish an Internet connection, it waits until the request times out, which substantially lengthens the 
product’s start-up time. This inability to verify the certificate also causes other problems, including:

• Services fail to start.

• Multiple instances of scriptserver.exe are spawned.

• Scans fail to complete.

To avoid the complications caused by a lack of Internet access, consider the following solutions:

• (Recommended) Manually download the required CRL and install it.

• Use Microsoft Windows Server Active Directory to store and publish a certificate revocation list 
(CRL). 

• Disable CRL checking for the server.

• Change the default CRL timeout period for the Microsoft Cryptography API (CAPI).

• Disable the “Check for publisher’s certificate revocation” option in Internet Explorer settings. To do so, 
click the Internet Explorer Tools menu and select Internet Options, click the Advanced tab, scroll to 
the Security section, clear the check box next to “Check for publisher’s certificate revocation,” then 
close and restart Internet Explorer.

The recommended solution is to manually download the CRL, and then install it to the local computer 
certificate store. 

To download the CRL:

1 Open a browser.

2 Go to http://crl.verisign.com/pca3.crl. 

3 When prompted, “Do you want to open or save this file,” click Save.
35

Misc_Roles.htm
http://crl.verisign.com/pca3.crl


4 On the Save As dialog box, select a location and click Save.

5 Go to http://csc3-2004-crl.verisign.com/CSC3-2004.crl. 

6 Repeat step 3 and step 4.

Note: Because the CRL is valid only for a limited time, you must retrieve a new CRL periodically. 

To install a CRL to the local computer certificate store: 

1 Log on to the computer as a member of the local administrators group. 

2 Open the Certificates snap-in for the Computer account: 

a Click Start, click Run, type mmc, and then click OK. 

b On the File menu, click Add/Remove Snap-in. 

The Add/Remove Snap-in dialog box appears.

c On the Standalone tab, click Add.

The Add Standalone Snap-in dialog box appears.

d In the Available Standalone Snap-ins list, click Certificates, and then click Add. 

e Select Computer account, and then click Next.

f Click Local computer, and then click Finish.

g Click Close, and then click OK.

3 Under the Console root, expand Certificates. 

4 Right-click Intermediate Certification Authorities, click All Tasks, and then click Import. 

The Certificate Import Wizard opens.

5 Click Next.

6 Click Browse.

7 On the Open dialog box, select Certificate revocation list (*.crl) from the Files of type list.

8 Locate and select pca3.crl and click Open.

9 Click Next and follow instructions in the wizard to complete the installation.

10 Go to step 4 and repeat the process to import CSC3-2004.crl.
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